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A. Overview 
 
This inkset is a variant of MIS Associates’ Eboni-6 inkset.1   Eboni-6 (“Eb6”) is a 
hextone,2 monotone,3 100% carbon pigment, black and white inkset for matte 
papers that runs on most Epson printers.  The Eboni-1400 inkset adds a single 
neutral photo black (“PKN”) ink for glossy printing and when cooler matte prints 
are needed.4 
 
Wikipedia states with respect to carbon inks, “The carbon particles do not fade 
over time even when in sunlight or bleached.”5   The most sophisticated third-
party fade testing that we have available to us is by Aardenburg Imaging & 
Archives.6  In these tests 100% carbon inks show very minor fade and result in 
the most lightfast and stable images tested.7  
 
All neutral-tone inks include color pigments to offset the natural carbon warmth, 
even if the inks are referred to as “carbon inks.”  Even if the colors are blended 
with the carbon so that no color dots show on close inspection, the color inks 
compromise the lightfastness and tonal stability of the prints.8 
 
Eboni is the most neutral carbon pigment I’ve tested that can be used in inkjet 
printers.   With some printers, profiles, and papers it is near neutral.  On the other 
hand, with many papers it is distinctly warm.  With the Epson 1400 printer it is 

                                                 
1
 See http://www.paulroark.com/BW-Info/Eboni-6.pdf for full information on Eboni-6. 
2
 There are 6 ink densities – full strength Eboni MK and 5 dilutions. 
3
 In a monotone inkset all inks are the same color.  Print tone can be varied somewhat by paper choice. 
4
 The 2% Eboni (Eb6-Y) is removed from this version of the inkset. 
5
 See http://en.wikipedia.org/wiki/Ink#Carbon_Inks.  See http://www.paulroark.com/BW-Info/R1800-

Lightfastness.pdf for more information on carbon ink stability.  Note that not all forms of carbon are this 

stable. 
6
 See http://www.aardenburg-imaging.com/  
7
 I have summarized the 30 MLux Hours Aardenburg Imaging results here:    

http://www.paulroark.com/BW-Info/AaI-30MLuxHr.jpg   

In a different AaI test, after 70 Mlux hours of exposure, the 100% Eboni MK patch showed no fade at all.  

This second test was for the equivalent of 35 years of display using the standards of Wilhelm Research.  

The paper used was Red River Polar Matte. 
8
 In general, color pigments fade faster and at different rates, causing tone shifting.  They also cause 
artifacts like metamerism. 
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always slightly warm, but with some papers and when framed with a natural 
paper mat board, the image can appear quite neutral. 
 
If color pigments are needed to cool the carbon pigments more than paper 
choice allows, it is still advantageous to start with the most neutral carbon 
pigment – Eboni – so that the least amount of colorant is needed.  Where 
lightfastness and image stability are high priorities, the very best color pigments 
should be used.  This inkset provides a choice of PKN inks for this purpose.  
Because the neutral PKN inks are pre-mixed carbon-color blends, controlling 
print tones and profiling is much easier than with high-gamut inks or toners, and 
there are never color dots on the print. 
  
The PKN ink is for both toning matte paper and printing on glossy papers.9  The 
1400’s tiny 1.5 picoliter droplets result in quite smooth neutral-cool prints.10  The 
choice of PKN inks includes the highly acclaimed Hewlett Packard Z3100 PK and 
the pre-loaded MIS UT14-C. 
 
B. Ink Positions 
 
The inks are as follows (from left to right in the 1400):11 
 
Y = Eb6-LM (6% Eboni, 94% clear base; LLK density) 
 
K = Eboni MK (MIS Associates carbon matte black ink) 
 
LC = Eb6-M (18% Eboni; LK density) 
 
LM = Eb6-LC (9% Eboni) 
 
M = Eb6-C (30% Eboni)12 
 
C = PKN (Neutralized photo black: HP Z3100 PK13 or MIS UT14-C) 

                                                 
9
 Note that I’m oriented to matte printing with 100% carbon pigments for my serious work.  If I were more 

oriented to glossy work, I might want to include a dilute neutral in (LKN) and gloss optimizer, such as in 

inkset “1400-NC2.”  See http://www.paulroark.com/BW-Info/1400-NC2.pdf 
10
 While my 1400 does not band visibly with a single Hewlett Packard Z3100 PK in the C-position, not all 

1400s may be made as well.  See the Image Structure section of this PDF, below. 
11
 If MIS carts are used, be sure to remove the tabs – usually yellow – that block the air intakes before 

installing the cartridges.  If CIS/CFS units are used, they must be agitated relatively frequently.  While all 

pigments settle with time, settlement with the dilutions of Eboni is faster than average.  Normal printing 

will agitate the carts.  If you refill the carts, agitate the bulk ink bottles periodically and before filling. 
12
 All of the above inks can be ordered from MIS.  See  http://www.inksupply.com/eb6.cfm for bulk inks.  

For pre-loaded carts, see http://www.inksupply.com/product-details.cfm?pn=EB6-1400-SET .  The chips 

on these carts slide out sideways, allowing the positions of the carts to be easily changed. 
13
 HP Vivera PK is considered by many and claimed by HP to be the best neutral black pigment.  HP color 

pigments are more stable than Epson pigments or any third party color inks.  In Wilhelm Research fade 

tests the HP B&W prints were rated at over 275 years on all matte papers if displayed under glass.  

http://www.wilhelm-research.com/hp/Z3200.html   In http://aardenburg-imaging.com/index.html fade tests 
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C. Printing Workflow Options – Epson Driver 
 
While the ultimate in control will come with a rip like QuadToneRip (“QTR”),14 the 
Epson driver can make excellent matte prints.  These prints will have some of the 
PKN in them, and thus some color pigments.  Nonetheless, they will still be more 
stable than any commercially available alternative of similar tone.15  Printing on 
matte paper with the Epson driver is a good place for a novice to start. 
 
 1. Epson Driver – Color Controls, Gamma 2.2 
 
Often the Epson driver with appropriate settings will produce matte prints that 
match a calibrated monitor’s relative densities.  This assumes that the working 
space of the image file is Gray Gamma 2.2.  This working space is the most 
common gray space, being a subset of Adobe RGB and sRGB.  It is used by the 
internet and is the default setting, directly or indirectly, in many image editing and 
other programs, such as scanners and digital cameras. 
 
See the screen grab of the Epson Driver Properties dialog box and the resulting 
Lab L (luminosity) or  characteristic curve (Kodak’s terminology from the film era) 
compared to the ideal Gray Gamma 2.2 characteristic curve, below.  

 

                                                                                                                                                 
after 40 Mlux hours of exposure (about 20 Wilhelm years) the HP-PK faded an average 0.53 Lab L units on 

the 3 papers tested. .http://www.paulroark.com/BW-Info/HP-PK.pdf shows how to remove the HP-PK ink 

from its large carts.  For the 1400 cart, buy an empty 1400 yellow position cart for the chip, which will be 

swapped with the other carts above to get the inks in the positions recommended.  No special tools or chip 

resetters are needed to deal with these auto-reset chips. 
14
 http://www.quadtonerip.com/html/QTRoverview.html  

15
 Particularly if the HP-PK is used, these prints will have less color pigment in them than any equal or 

cooler toned inkjet print, and the HP PK and color inks have tested as more stable than any similar inks. 
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As can be seen by the above graph, the Epson driver set to Color Controls with 
Gamma 2.2 reasonably matches the densities16 of a color-managed workflow 
using a custom ICC when the grayscale image file is Gray Gamma 2.2.  The 

                                                 
16
 I use the term “density” loosely and informally here.  The luminosity scale is in Lab L. 
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monitor is always color managed.  As such, if the file is using or edited in the 
usual Gray Gamma 2.2 space (or RGB or sRGB, as with most digital cameras) 
the print relative densities will match those of the monitor, which is very 
desirable. 
 
With the Epson driver, the PKN is used as well as the Eboni carbon inks from 
approximately 50% to 85%.  This reduces the Lab B by about 1 to 2 Lab B units 
in this range.  That is, the PKN cools the shadows a bit relative to 100% carbon.  
This results in more of a “split tone” with relatively warm midtones and cooler 
shadows.   Print tones are discussed below. 
 
 2. Epson Driver – ICC in Photoshop Print Preview 
 
The use of an ICC in the Photoshop or Elements Print Preview “color manages” 
the workflow, in the sense that a calibrated monitor will automatically give a good 
match to the print’s relative densities even if Gray Gamma 2.2 is not the working 
space.17  It may also give a slightly better match than the Epson driver without an 
ICC if the paper used does not produce the results shown above. 
 
Custom Grayscale ICCs are easy to make using QTR’s “Create ICC.” This 
program is part of the QTR download.  Briefly, ICCs are made with Create-ICC 
by printing a 21-step test strip and taking the Lab L readings from that test strip 
to, in effect, tell the printer how to match the monitor.  With Create-ICC on the 
desktop, a text (Notepad) file18 of the Lab L information from a test strip is simply 
dragged to the Create-ICC icon, and an ICC will pop out onto the desktop.  That 
then needs to be placed in the appropriate folder.19 
 
The ICCs are inserted in the Print Preview, as shown in the screen grab, below. 
 

                                                 
17
 ICCs can also be used to “soft proof” the print tones, but that is beyond the scope of this article. 

 
18
 ICCs are made for specific printers, papers and inksets, and the printer drivers must use the same settings 

as were used when the original test strip was made.  Thus, the name of the text file, which will be reflected 

in the ICC name, should include this information.    
19
 The ICC location varies for different computer OS’s:  (1) Windows XP or Vista folder: 

c:\windows\system32\spool\drivers\color\; (2) Mac OS 9.x:  Systems Folder/ColorSync Profiles; (3) Mac 

OS X:   User Library/ColorSync/Profiles; (4) Windows 98/M:   \Windows\System\Color; (5) Windows 

NT/2000 or XP upgrade from NT/2000:  \Winnt\system32\spool\drivers\color. 
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When one makes an ICC the use of a spectrophotometer to read the test strip is 
ideal, but one can also use a flatbed scanner for this purpose.   
See http://www.paulroark.com/BW-Info/Making_B-W_ICCs.htm for some tips on 
using Create-ICC with a flatbed scanner.  I use a ColorVision Print Fix Pro 
spectro.   
 
 
D. QuadToneRip (QTR)20 
 
The QTR rip provides the most control of the printer because it gives direct 
control of each ink position.  With this Eboni-1400 inkset, QTR allows 100% 
carbon on cotton-matte as well as glossy black-only printing.21   
I use Windows, so the following is based on the Windows QTR interfaces/GUIs. 
 
With Windows, QTR must be used as a separate program as opposed to printing 
directly from Photoshop.  The QTR rip is also not “color managed.”  As such, 
some way to match the monitor to the “straight-line” or “linear” output of QTR is 
needed.  Novices should probably first become comfortable with the Epson driver 
printing before learning QTR.  B&W enthusiasts will find QTR a very useful tool. 
 
 1. Making QTR Profiles  
 
  a. Glossy Paper – “Black Only” 
 
Glossy papers are printed using only the C-position PKN ink.  This is a type of 
“black only” or “BO” printing and is the easiest type of profile to make with QTR.  
Basically, all this takes is to (1) determine the ink limit (maximum ink output) that 

                                                 
20
  http://www.quadtonerip.com/html/QTRoverview.html   

21
 I’ve experimented with several different alternatives using Eboni and PKN inks.  See, e.g., 

http://www.paulroark.com/BW-Info/NC3.PDF and http://www.paulroark.com/BW-Info/1400-
NC2.pdf   The Eboni-1400 inkset discussed here seems the most convenient for my uses. 
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results in the best black (dmax), (2) print a 21-step test print with an appropriate 
black-only curve with this ink limit set, and then (3) linearize the profile.22 
 
   (1) Determine the Ink Limit 
 
Ink limits are usually determined when using QTR by printing a “Calibration 
Mode” print on the paper to be profiled.23  This will print a 21-step test print of 
each ink in the printer.  This is usually the appropriate first step.  However, with 
only one ink being glossy-compatible in this inkset, printing an entire page is slow 
and wastes of a sheet of paper.   
 
A faster alternative to the Calibration Mode print is to print a 21-step test file24 
with a simple QTR straight-line curve than simply goes from 0 to 100.  For this 
inkset, I call such a curve “C-0-100.”  To make a curve like this, open the Curve 
Creator (Tools>Curve Creation).  In the box under “Cyan,” scroll down to “Load 
Curve.”  Push the “Curve” button that will appear at the right.  This brings up a 
box that has 2 tabs. Click on the “Point List” tab.  In the “Curve Points” boxes 
enter (0, 0) and (100, 100) as the only coordinates.  You can press the “Preview 
Curve” button to verify the curve is a simple straight line between the bottom left 
and top right corners.  Press OK on the Point List box.  Check that the ink limit is 
set to 100.  The ink limit can be either in the “Default Ink Limit” box or the Limit 
box specific to Cyan.  Save this in the 1400-MIS folder.   
 
Once a C-0-100 profile is made, print a 21-step test print with it.25  Dry the print 
thoroughly, and determine which patch is the darkest.  For this, a 
spectrophotometer (“spectro”) is best, but a flatbed scanner can be used.  If, for 
example, the 65% patch on the test strip is the darkest one, then 65 is the ink 
limit for this ink on the paper tested. 
 
   (2) Find or Make a Starting Curve or Profile 
 
For a single-ink, black-only type profile, there are several ways to find an 
appropriate starting curve.  The easiest way is to simply label the C-position ink 
as a “Gray” ink in the QTR Curve Creator and put “100” in the Density box.  Set 
the ink limit to the level found in the above step.  Save the curve with an 

                                                 
22
 The profiles I’ve made were made with HP-PK in the printer.  See http://www.paulroark.com/BW-

Info/Eb-1400-Profiles.zip  to download there profiles.  If MIS PKN is used, they should be re-linearized. 
23
 To print a Calibration Mode print, in the main QTR GUI, click on Tools>Options>Calibration Mode.  

Center the image, be sure the “Ink Calibration” slider is set to 100, and the paper type is “matte” even 

though this is for glossy paper.  I always print at 2880 resolution and uni-directional.  
24
 See http://www.paulroark.com/BW-Info/21-Step.jpg for a Jpeg of the one I use.  Save this as a Tiff file.   

25
 For this purpose I use just ½” border at the top of the page, even though for actual prints a larger border 

is recommended.  I cut the printed test strips off the full sheet of paper, so that the paper can be used for the 

next test strip without the risk that the black ink will be transferred to the printer feed roller.  The 1400, 

typical of many modern printers, bands if top and bottom borders are too narrow.  Both sets of printer 

rollers are needed to give the best paper transport. 
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appropriate name, showing the inkset and PKN used.  Push the “Show Curve” 
button and the starting black only curve will be shown. 
 
   (3) Linearize the Curve/Profile 
 
Print a 21-step test file with this starting curve/profile.  Measure the dry test strip 
with a spectro or, if a spectro is not available, flatbed scanner.26  The Lab L 
readings, from paper white to 100% black, are then entered into the Linearization 
tab of the Curve Creator.  Press the “Show Curve” button and the file will be 
saved and the final curve shown. 
 
  b. Making Partitioned Profiles for Matte Paper 
 
For 100% carbon pigment prints on matte paper, all of the ink positions are used 
except the Cyan (PKN) to make the smoothest carbon print.  Additionally, an 
Eboni black-only (“BO”) curve can be made using the procedures outlined above.  
Finally, a neutral-cool profile can be made using the Cyan-PKN ink in 
combination with the Eboni MK.  These profiles can be blended with QTR sliders 
to make intermediate tones and split tones. 
 
Where multiple inks are used, they are “partitioned” such that only the lightest 
inks are use to print the lightest image values.  QTR includes a system to do this 
based on the relative print densities of the inks.  To use this system, the black ink 
and the midtone inks that are to be partitioned are labeled as “Gray” inks.  The 
ink limits must be determined and then the relative densities found. 
 
 
 
   (1) Ink Limits 
 
For this, a Calibration Mode print is made (Tools>Options>Calibration mode).  
The “Ink Calibration” slider should be at 100.   I use 2880 Uni-directional for the 
quality settings.   Once the print is thoroughly dry, measure the Eboni MK steps 
to see which one is darkest.  That determines where the dmax is reached.  One 
can use this number or, if there is a relatively low final slope, one might use 10% 
less as the ink limit and set the “Black Boost” to the patch number that resulted in 
the maximum density.   For example, in the Curve Creator shown below the 
densities increased only slightly from the 30% to 40% patch.  So, 30 was set as 
the ink limit for the black ink.  This often results in a straighter initial curve. 
 
 

                                                 
26
 See http://www.paulroark.com/BW-Info/Making_B-W_ICCs-GrayCard.pdf for how to use a flatbed 

scanner to linearize QTR. 
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For the midtone inks, the ink limits are a judgment call.  Inspect each one 
carefully to see where artifacts start to appear.  Too much ink will bleed and can 
cause microbanding.  In general, I try to keep the midtone ink limits low enough 
that the inks are still well separated and not into the final, relatively flat parts of 
their curves.   With a printer like the 1400, heavy use of the midtone inks is not 
needed for smoothness.  It often works well to simply use the K ink limit or dmax 
point as the midtone ink limit.  That is, just set that as the default ink limit and 
leave the midtone ink limit boxes blank. 
 
   (2) Densities 
 
Densities entered in the Curve Creator are the midtone ink densities at their ink 
limits relative to the black ink densities when the black ink is printed at its ink limit 
with a straight line curve.  The black ink density is always 100.  To find the black 
ink densities print a 21-step test strip with the black ink at its ink limit (not the 
Black Boost amount, if any), using a straight line curve/profile.  A second 
Calibration Mode print can be made with it’s slider at the black ink limit, but a 
faster method is to simply print a 21-step test file with, for example, a K-0-30 
curve if the black ink limit was 30.27   
 

                                                 
27
 See D.1.a.(1), page 6, above for how to make these straight line curves.  
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Another reason to use an ink limit that is less than the ultimate dmax is that it 
spreads the values of this K test strip better, making it easier to more accurately 
determine the relative midtone densities. 
 
Measure the black test strip and mark the densities next to the test patches.  I 
also write down the change in density per unit.  That is, find the difference 
between the adjacent patches and divide it by 5.   This helps determine the 
relative densities when the value being compared is not exactly the same as one 
of the 21 patches – which is normally the case. 
 
Measure the densities of the midtone inks at the limits selected for them.  These 
densities are compared to the K densities.  The number entered in the Curve 
Creator is the K test strip patch number or, usually, a number between patches 
that is derived by estimating what K percentage would have resulted in the 
density that matched the midtone ink’s density at its ink limit.  For example, in the 
sample above the LC ink at default ink limit 30 was just slightly below the K 
density at its 30% patch.  So, “29.5” was entered as the density number for the 
LC ink.28 
 
When all the relative densities have been filled in, and the profile is saved with an 
appropriate name (inkset and paper indicated in the name), the partitioned 
curves can be seen by clicking on the “Show Curve” button on the Curve Creator. 
 
   (3) Linearizing 
 
The final step in this profile building is to linearize the initial curves set.  To do 
this a 21-step test file is printed with the profile, and the Lab L values from this 
test strip are entered into the Curve Creator’s Linearization tab boxes.  With the 
numbers and methods in the sample, above, the pre-linearized 21-step test strip 
was already quite straight and smooth.  A relatively smooth initial curve usually 
results in a smoother final curve.   
 
Note that I use a ColorVision/DataColor Print Fix Pro spectro to read test strips.  
It outputs a text file that I can simply copy and paste into QTR’s linearization tab.  
I usually open the text file with Excel so that I can graph (Insert>Chart>Line) the 
results to see if the profile curve is relatively smooth.  A sharp bend in the graph 
often means the linearization will not be very good.  Also, ample deep shadow 
information (i.e., compressed shadows) helps the program result in a smooth 
final curve.  The shadows are often where most difficulties exist; actual 
information down there, as opposed to interpolation, helps.  
 
 
 
 

                                                 
28
 I have not measured the accuracy that QTR requires in these relative density calculations.  The system 

appears to be rather tolerant of estimates.  I suspect 2-digit accuracy is sufficient. 
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 2. Printing with QTR – Windows 
 
I use exclusively Windows computers.   Macs can print directly from Photoshop, 
whereas with Windows QTR acts as an independent printer utility. 
 
  a. Matching the Monitor and Print 
 
QTR is not, in and of itself, “color managed.”  That is, it does not automatically 
adjust the output to match the working space or embedded profile of the image 
file such that the relative densities displayed on the monitor will be reflected in 
the print.29  QTR prints with a straight-line response or characteristic curve.  
None of the common working color spaces use this density distribution.  I usually 
save a Tiff file to the desktop that has the print size and other final printing 
adjustments to it.  QTR prints only grayscale Tiff files.  Files are flattened, profiles 
ignored, and 16 bit files are converted to 8 bit for printing. 
 
As discussed earlier, the most common gray working space is Gray Gamma 2.2.  
The graph below shows the difference in relative densities between how a Gray 
Gamma 2.2 (“GG 2.2”) file will look on the monitor and print with a color 
managed system, versus how it will print with QTR. 
 

 
 
If a file is edited in Gray Gamma 2.2 it will not result in a print from QTR that 
looks like the monitor.  Because the GG2.2 shadows are compressed and QTR 
shadows are linear, a GG2.2 file will appear lighter and perhaps lacking in good 
blacks when printed with QTR. 
 
There are two basic approaches to matching the monitor’s display and QTR print.  
First, if QTR printing is the primary objective one has in editing a file, it may make 
sense to edit the file in a manner that it will print with QTR and look like it did on 

                                                 
29
 Mac users can insert matte or glossy QTR ICCs in the PS Print Preview to get the advantages of color 

management with QTR.  Windows does not support this type of printing. 
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the monitor with no further conversions or modifications to the file.  The QTR 
download includes ICCs that can be used for this purpose.  These are located in 
the /QuadToneRip/ICC folder.  There is also a Readme file in the /QTR/ICC 
folder that explains the use of the ICCs.   When I was editing only for printing with 
a rip like QTR, I used the soft-proofing approach (View>Proof Setup>Custom).  I 
no longer use these approaches. 
 
Second, if QTR printing is just one of several expected uses of the file, it might 
make sense to edit the file using the, de facto, standard working space – Gray 
Gamma 2.2 – and then adjust a copy of the file as needed to print with QTR only 
when ready to print.   One method of doing this is to convert the file 
(Edit>Convert to)30 to the Gray Matte or Gray Photo spaces, for matte or glossy 
papers, respectively, with the QTR ICCs.   
 
Alternatively, one can apply a Photoshop image adjustment curve that makes 
this conversion. This is what I do.  The graph below compares the matte paper 
print densities (Lab L, technically) resulting from, first, a color-managed workflow 
where the file used the Gray Gamma 2.2 working space and the printer was color 
managed with a custom ICC with, second, a QTR workflow where the “GG22-to-
QTR.avc” curve was applied to the file before printing with QTR.   They are 
virtually identical.  In short, the GG22-to-QTR curve replicates the Gray Gamma 
2.2 output characteristics for matte papers, allowing one to edit in that standard 
working space and match the output to the monitor when QTR is used to print the 
file.   
 

 
 
The “GG22-to-QTR.avc” curve can be downloaded along with various other 
relevant curves and profiles at http://www.paulroark.com/BW-Info/Eb-1400-
Profiles.zip  
 

                                                 
30
 Use Perceptual and Black Point Compensation.  Note that the dmax might be slightly affected. 
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Note that as good as color management is, variations in display lighting cannot 
all be accounted for.  One advantage to using a PS image adjustment curve, 
which can be on a layer, is that the user can modify it to also account for 
individual lighting variables. 
   
 
E. Print Tones 
 
The print tones produced by the Eboni-1400 inkset range from neutral-cool when 
the PKN is used to warm when the dilute carbon inks are used. 
 

 
 
Neutral prints are easily made with blended carbon-color inks like the HP-PK.  As 
shown in the graph above, dilute Eboni carbon inks print more warmly, with 
concentrated carbon black-only in between.  When only 100% carbon pigments 
are used the tones can range from near neutral-warm to warm depending on the 
paper and profile used. 
 
In general, the maximum Lab B value (yellow-blue axis) indicates the warmth of 
the print.31  The higher the Lab B value, the warmer the print will appear.  The 
difference between the paper tone and the maximum midtone Lab B also affects 
the sense of warmth, as the eye tends to do an automatic white balance on the 
paper white or other white reference (like the mat board).  Lab B values always 
rise from the paper white when 100% carbon is used.   The maximum Lab B 
values with 100% carbon have ranged from about 2 to 6 with matte papers.32  
 

                                                 
31
 Lab A (red-green axis) also affects tone, but it is essentially set by the paper and remains relatively 

constant.  A slightly positive Lab A (red/magenta) is generally preferred to avoid the print taking on a green 

tint; thus all of the papers show this characteristic to some extent.  
32
 Note that drop size affects carbon print tone.  Larger drops produce more neutral prints, particularly on 

coated inkjet papers.  With the old 7500 and Premier Art Smooth BW, the Eboni-6 Lab B rises from about 

negative 2 to 0. 
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With the 1400, the lowest Lab B change when the dilute Eboni inks are used is 
with Arches watercolor paper (2.8 units),33 while the most neutral appearing 
100% carbon print maybe on Premier Art Smooth Bright White34 due to its 
brightened (cool) paper.  There the Lab B range is approximately -2 to +2.  
 
The choice of paper makes a significant difference in print tones with dilute Eboni 
inks.  The graph below shows the tones for Red River Premium Matte, Arches 
(uncoated) watercolor paper, and Premier Art Smooth BW. 
 

 
 

Other papers that print with relatively neutral print tones include Hawk Mountain’s 
Condor BW, Moab Entrada BW, and Brightcube Eclipse.   None are quite as 
neutral as the Premier Art Smooth BW, however.     
 
Note that a mat board like Light Impressions Exeter “Gallery White” has a  
Lab B = 3.  When displayed in these over-mats with no paper-white margin 
showing, the eye, in effect, uses the mat board as a white reference.  When 
matted in this manner, the Premier Art Smooth BW will look quite neutral, with 
relatively cool highlights that appear to be brighter than the mat.  This tends to 
pull the eye into the picture. 
 
Many photographers believe that a split tone between the paper white, warmer 
midtone values, and then cooler shadows gives the image not only a pleasant 
warmth but also a sense of higher dynamic range.  This is because the tonal 
(Lab B) differences as well as the luminance values may help to separate the 
image elements.  Cooler shadows look blacker, particularly in warm indoor 
lighting.  That was one of the secrets of the selenium toned silver prints.  On the 
other hand, the eye sees cooler highlights as brighter even if they are not brighter 
according to spectro readings.  This is one reason why most popular papers use 

                                                 
33
 On the 7500, this range is 2.6. 

34
 See http://www.premierimagingproducts.com/pm_smoothbwfineart.php     
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optical brighteners, which give the paper a slightly blue cast.  Silver prints also 
used optical brighteners.  
 
I have tended to use cooler papers with lower split tones like Premier Art Smooth 
Bright White for landscapes where there are clouds or snow, and use the warmer 
papers with more split tone for southwestern scenes.  Many also prefer warm 
tones for images of people. 
 
 Arches Watercolor Paper 
 
Most recently I’ve been exploring the use of Arches Hot Press Bright White (no 
optical brighteners) uncoated watercolor paper due to its excellent reputation in 
the painting field.  Some conservators believe any coated substrate will separate 
with time due to differential expansion from temperature and humidity changes.  
In the old photo digital restoration work I’ve done the very old photos typically 
have cracked surfaces.  Not only does Arches paper avoid coating the cracking 
issue, but it also can be washed to eliminate the non-image forming ink 
substances and loose carbon pigments.  This results in what may be the most 
durable inkjet print I’ve experienced. 
 
Below are the Lab B distributions for several profiles that this inkset allows on 
Arches HP BW.  The fully-partitioned 100% carbon profile (“Full-Part”) is the 
warmest and smoothest.  The black-only profile (“BO”) is more neutral; it is also 
rougher than many will like.  Where the black-only profile is combined with the 
partitioned profile, in equal amounts, (“BO=P”) one gets a 100% carbon print that 
is reasonably smooth.  If HP-PK is used as the only midtone ink in a profile, the 
resulting tone curve (not shown) is flat.  Of more interest, due to its higher use of 
carbon and more pleasing tone, is a print that combines three profiles – HP-PK, 
BO, and fully-partitioned – in equal amounts.  The resulting print is quite neutral 
(relative to the natural paper) with much better smoothness than if just the BO 
profile is used.   
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While the midtone smoothness of prints on Arches watercolor paper cannot 
equal the coated inkjet papers where partitioned, dilute inks are used, I suspect 
most will find it very satisfactory for 11 x 14 inch prints, making this paper an 
interesting alternative. 
 
 
 
F. Image Structure 
 
The image below shows small sections of prints scanned at 1600 dpi on an 
Epson flatbed scanner.  The scans give an objective comparison of print 
smoothness.  The papers used were the Premier Art Smooth Bright White 300 
gsm (PaBW300), Red River UltraPro Glossy 2.0 (RR-UPG2), Arches HP BW 
watercolor paper, and Epson Enhanced Matte (EEM).35 
 

                                                 
35
 With the Eboni-1400 inkset there are no color dots, unlike the Epson 4800 “Advanced B&W” mode 

print. The HP-PK ink is neutral black, but the Red River UltraPro Glossy 2.0 paper is quite cool (bluish), 

and it shows in this scan.  The Premier Art and Arches prints are with 100% carbon.  The PaSmBW print 

on the left used the dilute inks, whereas the one to the right was Black-Only (Eb-BO). 
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The test patches shown above are, on the print, only 1.75 mm high.  So, to get a 
better idea of smoothness, adjust your viewing distance from the monitor.  On my 
monitor the images are 35 mm high.  So, if the normal print viewing distance is 
14” (as stated by Kodak), I’d have to view my monitor from a bit more than 23 
feet away to adjust for the magnification shown here. 
 
 
G. Final Thoughts 
 
The Epson 1400 is a very affordable 13” printer that can support a range of 
different inksets and workflows, particularly when QTR is used to control the inks. 
 
A 100% carbon pigment printing workflow probably makes the most stable inkjet 
images possible with today’s technology.  The addition of the HP-PK, however, 
allows not only quite good glossy printing but also probably the most stable prints 
possible for the tones that are more neutral than 100% carbon can reach.    
 
Enjoy the journey. 
 
Paul 
www.PaulRoark.com  


